リモートセンシング
ERDAS Imagineを用いた基礎的なRSデータ処理

1. 基本操作

　衛星画像を表示・解析するためのソフトウェアを起動させます。使用するソフトウェアはLeica Geosystem社のErdas Imagine 8.7です。スタートメニューから，プログラム ＞ Leica Gosystem GIS & Mapping ＞ Erdas Imagine 8.7を選択して下さい。ウィンドウがいくつか表示されますが，そのうちSelect Viewer Typeウィンドウをアクティブにし，Viewerウィンドウの種類を選択します。今回はClassic Viewerを選択します。以上の操作で，2つのウィンドウが表示されているはずです。画面上部にある横長のウィンドウは，アイコンパネルと呼ばれ，様々な機能を呼び出すために使用します。Viewerウィンドウは衛星画像を表示させる機能を持ちます。

	衛星リモートセンシングの仕組みと反射特性
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　衛星センサ(Sensor)は，地球を周回している衛星プラットフォームに搭載されていて，光源(太陽)からの電磁波が地表面の物質を反射して，センサに戻ってくる強さ(電磁波の強さ)を観測します。センサは面的に地表面の電磁波の強さを観測し，その観測した結果を地上の受信局に送ります。そして受信局で受け取った信号を画像化します。

　地表面の物質は，波長帯ごとに電磁波の反射に特徴があります(反射特性があるという)。例えば，植物の葉は可視光の中では人間の眼で見える青や赤の波長帯よりも，緑の波長帯で比較的強く反射する特徴があります。またそれより波長が長い近赤外線で特に強く反射します。
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　衛星センサは，地表面の反射特性の特徴を基に，地表面の物質の特徴を識別しやすくできるように，特定の波長帯の電磁波を観測します。これからの演習で使用するLandsat／TMには，特に人間の眼で見える可視光の波長帯として，青色の波長帯のBand 1（0.45～0.52μm），緑色の波長帯のBand 2（0.53～0.61μm，緑），赤色の波長帯のBand 3（0.63～0.69μm，赤）と呼ばれる3つのバンドがあります。また，植生を識別するために，Band 4（0.75～0.9μm，近赤外），Band 5（1.55～1.75μm，近赤外），Band 7（2.09～2.35μm，中間赤外）があります。Band 6（10.4～12.5μm）は熱赤外の波長帯で，地表面から放射される電磁波を観測し，地表面の暖かさがわかります。植生や水域の反射特性の説明は，第4章で詳しく説明します。

＜参考Website＞

· NASA GSFC「Remote Sensing Tutorial － Introduction」：http://rst.gsfc.nasa.gov/Intro/Part2_6.html
· リモートセンシングI「軌道上からのリモートセンシング」：http://web.sfc.keio.ac.jp/~kipinga/RSI/rs4/
· 画像情報論「リモートセンシング」：http://web.sfc.keio.ac.jp/~kipinga/IA/ia_4/


　Viewerに衛星画像を表示させてみましょう。

1. Viewerウィンドウの上部にはアイコンがたくさん並んでおり，この部分をツールバーと呼びます。その中の一番左のアイコン[image: image2.bmp]をクリックする。

2. 衛星画像のファイルを選択するためのウィンドウが表示される。今回使用するファイル(90_landst.img)を選択し，OKをクリックする。
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3. Viewerウィンドウ内で右クリックし，"Fit Image To Window"を選択し，衛星画像を全体表示させる。

　Viewerには全体的に赤色の画像が表示されているはずです。これは，フォルスカラーコンポジットと呼ばれる衛星画像のカラー合成の組み合わせの1つです。
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RGBモデルによるカラー合成

　人間の見える光の三原色は，右の図のように赤（R），緑（G），青（B）です。この3つの光の強さ(輝度)を組み合わせで色を表現するのが，RGBモデルによるカラー合成です。デジタルカメラで撮影されたカラー画像の情報も， RGBに分けて輝度の強さが保存されています。衛星画像もこれと同様の方法で表示されています。

　Landsat/TMには，青はバンド１，緑はバンド２，赤はバンド３となっているので，この組み合わせにすることで，人間の眼と同じように見ることができます。このように，R,G,B=3,2,1の組み合わせをトゥルーカラーコンポジットと呼びます。他にも，R,G,B=4,3,2のフォルスカラーコンポジットと呼ばれる組み合わせや，R,G,B=3,4,2のナチュラルカラーコンポジットと呼ばれる組み合わせもあります。

＜参考Website＞

· JAXA EOC「光学センサを利用したカラー合成」：http://www.eoc.jaxa.jp/experience/dataproc/p03.html
· NASA GSFC 「Remote Sensing Tutorial － Section 1」：http://rst.gsfc.nasa.gov/Sect1/Sect1_8.html
http://rst.gsfc.nasa.gov/Sect1/Sect1_10.html，http://rst.gsfc.nasa.gov/Sect1/Sect1_11.html


　すでに表示させているViewerから，カラー合成の組み合わせを変更させます。

1. Viewerウィンドウのメニューから，Raster > Band Combinationを選択する.。

2. 表示されたウィンドウの右側の数字(Layer)はバンドを表しており，上から赤，緑，青を表している。デフォルトでは，R,G,B=4,３,２のフォルスカラーコンポジットであることがわかる。
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3. 数字の組み合わせを変更すると，画像の色が自動的に変更される。

　トゥルーカラーコンポジットやナチュラルカラーコンポジットなどを試して見ましょう。また，それ以外の組み合わせを試してみてください。

　また，ファイルを選択させるウィンドウで，バンドの組み合わせを設定することも可能です。Viewerに表示させるファイルを選択した後，Raster Optionタブをクリックし，Display as:をTrue Colorを選択することで設定可能です。白黒画像であるグレースケール画像はGray Scalesを選択し，表示させるバンドはLayerで設定します。

　今までは衛星画像の全体を俯瞰していましたが，今度は画像を拡大し，地表面の細かい様子を観察します。ツールバーのアイコン[image: image6.bmp]をクリックします。そして画像をクリックすると，拡大されて地表面の細かい状況が見ることができます(Zoom In)。反対に全体を表示させていくには，縮小機能の[image: image7.bmp]を使います(Zoom Out)。また，手の形をしたアイコン[image: image8.bmp]は，ドラッグしながら画像表示部分を移動させることができます。他にも，[image: image9.bmp]は拡大，[image: image10.bmp]は縮小を行うことができます。

2. 画像強調

2.1. コントラスト強調

　画像強調とは，衛星画像を人間の眼で見やすくするために行う処理です。わずかな値の違い・変化を強調して，画像の情報を視覚的に引き出すことが狙いです。ではなぜこのような処理をするのでしょうか。まず次のヒストグラムを見てください。
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　これはバンド4のヒストグラムです。下部の白黒のグラデーションは，画素値に割り当てる色です。画素値に割り当てる色はあらかじめ表として決められており，この対応をLookup Table(LUT，彩色対照表)と呼びます。上のヒストグラムによると，画素値はだいたい1から120あたりであるため，上図のLookup Tableの場合，全体的に黒っぽくなり，はっきりしない見にくい画像となります。従って，見やすくするためには，Lookup Tableを変更し，黒～白の色を全体で使うことができるように，LUTの色の対応を変換する必要があります。

	コントラスト強調（Contrast Enhancement）

1 Linear Contrast Stretch

　最も基本的な方法で，画素値を線形変換する方法です。一般的には，画素の最小値を0に，最大値を255にするように線形変換を行って強調を行います。他にも画素値の最大値と最小値から累積5%（変更可能な場合もある）の画素を基準にして，それぞれ最大値と最小値に割り当てて線形変換する方法や，平均値と標準偏差を使用して，平均値±標準偏差を基準にして最大値と最小値を決定する方法(Standard Deviations)もあります。

2 Histogram equalization

　この方法では，変換後の画素値のヒストグラムが，同じ値を持つ画素の頻度が等しくなるように値を変換する方法です。例えば，右表のようにLUTの値が0から15の画像があったとします。右側の画素数がその値を持つ画素の数で，累積画素数は値が低いほうから画素の合計数を数えていきます。画像の全体画素数は262144で，LUTの値は全部で16階調なので，全体の画素数から16で割ると16385となります。この数字は，1つのLUT値が持つことができる画素数となります。従って，LUT値が次のLUT値に移るまでには累積画素数が16385を超える必要があります。最初に累積画素数が16385をこえるのは変換前LUT値が3の時で，このときにはじめてLUT値が1に変換され，それまでのLUT値0と1は0のままとなります。これを最後まで行い，変換が完了します。

＜参考Website＞

画像情報論「色彩と種々の画像パラメータ」：http://web.sfc.keio.ac.jp/~kipinga/IA/ia_3/


　Linear Contrast Stretchを行う方法を説明します。

1. 90_landsat.imgをGray Scaleのバンド4で表示させ，広州市市街地全体をViewer全体に表示されるくらいまで，画像を拡大する。

2. ViewerウィンドウのRasterメニューからData Scalingを選択する。

3. Set Data Scalingウィンドウで，MinとMaxの値を任意に変化させて，コントラスト強調を行う。

　はじめはMinを0とし，Maxを255にしてみます。実行すると，前より暗い画像に変わります。実は，このソフトウェアではViewerで表示する際に自動的にストレッチを行っていることがわかります。次はMaxとMinの値をかえてみましょう。Minの値を大きくし，Maxの値を小さくすると，見た目がはっきりとしてきて，コントラストが明瞭となります。
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　次に，変換前と後のヒストグラムが表示できるウィンドウを表示させ，Histogram Equalizationを実行します。

1. RasterメニューからContrastを選択し，Breakpointsを選択し，Breakpoint Editorを起動させる。
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2. Histogram SourceをViewer Extentにし，現在表示されている部分だけ処理を行うように設定する。

3. Breakpoint Editorのヒストグラム内の黄色のグラフが変換後のヒストグラムで，灰色が変換前のヒストグラムが表示されており，グラフ内の線は変換の対応を表したものである。

4. ViewerウィンドウのRasterメニューから，Contrast > General Contrastを選択し，Contrast Adjustウィンドウを表示させる。

5. Methodでストレッチの種類を選ぶことができるが，今回はHistogram Equalizationを選択する。
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6. Histogram SourceはWhole Imageにチェックする。

7. Number of Binsの値を変更して，Applyをクリックする。

8. Breakpoint Editorのヒストグラムが変更されているので確認し，このストレッチで良い場合はApplyをクリックすると，Viewerの画像のコントラストが変化する。グラフ上を右クリックして，Undo all editかUndo last editを選択すると，グラフが元に戻り，Applyをクリックすると，Viewerのストレッチも元に戻る。
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　以上がコントラスト強調の方法でしたが，これらの方法はあくまでも画像を見やすくするための手段に過ぎません。実際の衛星画像が持つ値とは異なっていることを，はっきりと認識する必要があります。強調した値で後に説明する演算や分類等の処理を行うことはできません。

2.2. 空間フィルタリング

　衛星画像は格子状の画素に値が格納されたものですが，対象物の位置や形状，大小，色，近接関係が情報として含まれていています。このような情報を強調・抽出することが空間フィルタリングの目的です。具体的には，空間的に変化の大きい箇所の強調やエッジの抽出，ノイズや変化が大きい画像を平滑化する作業を行います。

	空間フィルタリングの種類と原理

　フィルタリングの方法は数多くあります。類型化すると以下の種類に分けることができます。例の部分がフィルタリング手法の名前です。

種類  
出力  
例  
機能
線形フィルタ 
重みつき和
Low Pass Filter
High Pass Filter

　方向フィルタ
画像強調・平均化等・
センサシミュレーション
統計フィルタ 
指定した統計値
最小値 (Min)
最大値 (Max)
中間値 (Median)
平均値 (Mean)
標準偏差 (Std)
最頻値 (Mode)
　
ノイズの除去
特徴抽出
信号ノイズの比

　
微分フィルタ 
勾配の大きさと角度 
Sobel
Roberts
Prewitt
エッジ抽出
　最も単純なLow Pass Filterを例にして，フィルタリングの方法について簡単に説明します。フィルタリングを行うには，移動する窓の存在が重要です。この窓にはサイズが決まっていて，窓は画像の左上から処理を開始します。窓はその範囲内の画素を利用して，処理を行い，その処理が終了したら，右に1画素分移動し，最終的には右下まで移動して処理を行います。左の図は3ピクセル×3ピクセルの例で，奇数であればサイズはいくらでも自由に設定することが可能です。
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　実際の処理では，まず窓内でのピクセルと重みつきWiの積を計算します。Low Pass Filterの場合，Wiは全て1なので，画素の和が計算されます。そして，窓の中の画素数である9で割ります。その計算結果を出力画像で入力画素の窓の中心にあたるところに値を格納するのです。そして窓は1画素右側にずれて，同じ処理を行うのです。Low Pass Filterは，周囲の画素値を使って割ることから，値を平滑化させることとなります。一方，線形フィルタの他の方法である，High Pass Filterは，Low Pass Filterとは逆に，中心の画素値と周囲の画素値の違いを強調します。重みつきWiは右のようになります。（説明は次ページに続く）
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　High Pass Filterの種類の1つとして方向フィルタがあります。このフィルタでは斜め（対角方向），横，縦（水平，垂直方向）の方向それぞれの画素値の変化や境界を強調することの有効な手法です。重みつきは以下の図のようになります。
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　統計フィルタも，線形フィルタと原理はほぼ同じで，窓の動きは同様です。窓の中の画素値を参照して，最大値や最小値などの統計量を計算して，出力画像に窓の中心と対応するところに統計量を格納させます。

　微分フィルタは，エッジを強調するのに有効な手法です。1次微分，2次微分の2種類の方法が知られています。1次微分としてはRoberts，Sobel，Prewittなどがあります。重みつけWiは下の図となります。水平成分と垂直成分があり，それぞれの重みつけでフィルタリングを実行し，画像が出力されたら，|A| ＋|B| 又は （A2 + B2）1/2 を計算します。

　2次微分はラプラシアンフィルタが良く知られています。1次微分では垂直方向と水平方向それぞれを1次元として扱いましたが，2次微分は1度に2方向のデータを扱います。したがって，方向性にとらわれずにエッジを強調することができます。重みつけWiは右の図に示します。

　他にも様々な種類のフィルタリング方法が提案されています。衛星画像に対して，様々なフィルタリング方法を試行錯誤で適用し，目的にあった画像を作成してみると良いでしょう。

＜参考ウェブサイト＞

· Department of Geography, University of Delaware「Introduction to Environmental Remote Sensing － Spatial Filtering」：http://www.udel.edu/Geography/DeLiberty/Geog474/geog474_convolution.html


　Viewerから線形フィルタと微分フィルタを行う方法を説明します。

1. Viewerにフィルタリングを行う衛星画像(90_landsat.img)を表示させる。

2. メニューバーのRaster > Filteringを選び，Convolution Filteringをクリックする。
Convolveウィンドウが表示され，Kernelで処理の種類を選択。また，Kernelを選択してEditをクリックすると，新しいウィンドウに重み付けが表示させることが可能である。
[image: image22.png]Kemel Libray: (Kb}

Apply

default ks =
Kernet New.
363 Edge Erharce.
343 Low Pass Tlese.
343 High Pass.
363 Horzortal Help
343 Vertcal

Preview

7 Nomaiize Kerel

ApplpTo: C AOI

€ Wholelmage © OnDemand





3. Previewの下には実行した例があるので，それを確認した後に，Applyをクリックするとフィルタリングが実行される。

　統計フィルタもViewerから行うことができます。

1. Viewerにフィルタリングを行う衛星画像を表示させる。

2. メニューバーの"Raster" > "Filtering"を選び，"Statistical Filtering"をクリックする。

3. 新しく表示された"Focal Function"ウィンドウ内の"Function"でフィルタリングの種類を選択し，"Window size"で窓の大きさを設定する。
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4. Applyをクリックすると実行されますが，ストレッチしたLook up tableのまま(表示の明るさのまま)でフィルタリングを実行するか，ストレッチしていない画素値でフィルタリングするのかを決める必要がある。Applyをクリックして最初に表示されるAttentionウィンドウを"No"をクリックすると，ストレッチしたままの画像に対してフィルタリングが実行される。"Yes"をクリックすると元の画素値に対してフィルタリングを行うので，やや暗い画像になる。

　Viewerからフィルタリング方法の他に，アイコンメニューのInterpreter > Spatial Enhancementを選択することで，いくつかのフィルタリング方法で処理をすることができます。
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3. 画像情報の表示

　本章は，画像の情報を定量的に得るための方法を説明しています。

3.1. Imageinfo

　画像の持つ統計等の情報を表示させましょう。Viewerウィンドウのアイコンメニュー内にある，[image: image27.bmp]をクリックし，Image Infoウィンドウを表示させます。ウィンドウ上部のアイコンメニューの右側にある数字は，バンドを表していて，バンドごとに画像の統計情報を切り替えて表示させることができます。

　Generalタブ内のLayer Infoには，画像の大きさやデータの形式が記述されています。Widthは画像の横幅を，Heightは縦の長さを画素数で表しています。他にはData Typeが重要です。Unsigned 8-bitとなっていますが，これは，画素値が0から255の値をもつ画像ということを表しています。このUnsignedはSignedの場合もあり，プラスとマイナス両方の値を持つことをあらわします。その他の形式としては8-bitではなく，16-bitの場合もあります。Unsigned 16-bitでは0から65536の値を持ちます。

　Statistics Infoはバンドごとに画像全体の統計量を表示します。Min，Maxはそれぞれバンドごとの画像の最小値と最大値を表します。中央値であるMedianや，画素が持つ値で最も数が多い画素値を表すMode，平均値Mean，標準偏差Std Dev"表示されます。
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　次にこのImageInfoウィンドウのGeneralタブから，Histogramタブをクリックすると，バンドごとの画素値のヒストグラムが表示されます。横軸は画素値，縦軸には画素数（頻度）です。赤い縦ラインは平均の値の場所を表し，青い縦ラインはそれぞれ，最大値と最小値の箇所を示しています。ヒストグラムによって，画像全体がどのような値を持つのかがわかります。全てのバンドでヒストグラムを見てみましょう。
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　ヒストグラムは画像全体の情報を表しますが，今度は細かい情報を表示させます。現在"Histogram"タブのウィンドウが最前面ですが，次に"Pixel data"タブをクリックします。セル1つ1つは画素を表します。つまり，画素値を画像の色ではなく，値として表示したことになります。

3.2. Inquire cursor

　Inquire cursorによる画像情報の表示方法を説明します。 Viewerウィンドウから直接，画像を表示させます。そして，アイコンメニュー[image: image30.bmp]をクリックします。新しいウィンドウが表示され，Viewer内に白い十字の線が入ります。白い十字線の交差する箇所の画素の値が，新しいウィンドウ内テーブルのFile Pixelの列に表示されます。また，Histogramの列には，同じ画素値を持つ画素数が表示されます。Viewerウィンドウのアイコン[image: image31.bmp]をクリックし，交差した部分をドラッグで移動させると，移動先の画素の値に切り替わります。
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3.3. Profile tools

　次に，Profiler toolsによる画像情報の表示方法を説明します。Viewerウィンドウのアイコン[image: image33.bmp]をクリックします。Select Profile Toolウィンドウが表示され，Spectral，Spatial，Surfaceの3種類を選択できます。"

　Spectralは，ある箇所（画素）の全てのバンドの画素値をグラフで表してくれる機能です。Spectral Profileウィンドウ内のアイコン[image: image34.bmp]をクリックし，画素値を読みたい箇所をクリックすると，グラフに値が描画されます。もう一度，[image: image35.bmp]をクリックして，Viewer内の任意の箇所をクリックすると，複数地点の画素の値をプロットすることができます。
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　次のSpatialは，画像上に線を引き，その線上の画素値で断面図を作成してくれます。ウィンドウ内のアイコン[image: image38.bmp]をクリックし，Viewerウィンドウ内で線を描画させます。1回クリックして，もう1回クリックすると，Viewer内に線が描画されます。ダブルクリックで線の描画が終了し，グラフにその線に沿った値がプロットされます。Plot Layerの右の数字でバンドを切り替えることができます。
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　Surfaceは特定の範囲の画素の値を地形のように3次元で表現してくれます。ウィンドウを表示し，アイコン[image: image41.bmp]をクリックします。Viewerウィンドウ内で四角を描画するとグラフにその範囲内の画素値で地形のように3次元表示されます。Plot Layerでバンドを切り替えることができます。また，ウィンドウ内のメニューEdit < Overlay TrueColorを選択すると，衛星画像を上に被せることもできます。
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4. 植生域・水域の衛星画像解析

4.1. 植生の反射特性

　植生の葉は一般的に，緑の領域で赤や青と比較して反射が強く，近赤外で最も強く反射します。この原因は，葉の内部構造にあります。太陽光が葉に入射し，赤と青は光合成に使われるため，葉緑素によって吸収されます。近赤外の電磁波は葉の内部まで進み，細胞壁で強く反射されます。
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（図の出典：http://web.sfc.keio.ac.jp/~kipinga/RSI/rs6/）

　葉の反射特性は，草や樹木等の植生のタイプで反射特性が異なります。草地は樹木の葉と比べると活性度が強く，近赤外の反射が強い傾向にあります。また，葉の水分量によっても異なり，中赤外の波長域で違いが現れることがあります。さらに，樹種によっても，わずかに反射特性が異なることがあります。他の要因としては季節変化によって反射特性が異なる場合や，植物の年齢でも異なります。 
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（左図の出典：http://www.crisp.nus.edu.sg/~research/tutorial/optical.htm，

右図の出典：http://web.sfc.keio.ac.jp/~kipinga/RSI/rs6/）

　上図左をみると，植生域と非植生域には大きな違いがあることがわかります。また，上図右を見ると，森林域よりも草地・農地の方が近赤外の反射は強いことが現れています。ただ，このような反射の特徴は一般的な場合を示したに過ぎないので，だいたいの傾向は当てはまるとしても，この特徴を完全に鵜呑みにするのは危険です。

＜参考ウェブサイト＞

· NASA GSFC 「Remote Sensing Tutorial －Section3 」：http://rst.gsfc.nasa.gov/Sect3/Sect3_1.html]

· UCS, University of South Carolina 「Principle of Remote Sensing － Exercise #6」：
http://www.cla.sc.edu/geog/Rslab/551/e06.html
4.2. 散布図の作成

　反射特性のグラフをみると，赤の波長帯で少し反射率が低下し，近赤外の波長帯で一気に反射率が高くなることがわかります。この赤（バンド3）と近赤外（バンド4）を使って散布図で表現すると，植生域と非植生域の違いを効果的に表すことができます。

1. アイコンパネルから，Classifer  > Feature Space Imageを選択する。

2. Input Raster Layerに90_landsat.imgを記入

3. Output Root Nameには90_landsat.imgと同じディレクトリに保存し，90_landsatとする

4. Output To Viewerにチェックを入れる

5. ウィンドウ下部の表は，2バンド間の全ての組み合わせが表示されている。X Axis LayerとY Axis Layerの列の番号がバンドを示していて，X軸とY軸がそれぞれ，バンド３と４である，FS Image 12の行を選択し，黄色で表示されたのを確認してから，OKをクリック。
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　散布図が表示されました。次にViewer上の箇所が，散布図のどこに位置するのかを示す方法を説明します。

1. 散布図を表示させ，アイコンパネルから，Classifier > Signature Editorを選択

2. Signature EditorウィンドウのFeatureメニューからView > Linked Cursorsを選択
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3. Selectをクリックし，散布図のウィンドウを1回クリック

4. 散布図を作成するために使った元画像を表示

5. Linkをクリックし，元画像のウィンドウを1回クリック

　散布図と元画像に白い十字線が入り，これは交差した箇所の画素値を読み取っていることを表します。元画像のほうの交差箇所をドラッグで移動すると，その箇所の画素値に対応して，散布図の交差箇所が移動します。

4.3. 正規化植生指標NDVI

　赤の波長帯の吸収と，近赤外の波長帯で強く反射する違いを利用して，植生指標と呼ばれる指標が提案されています。この指標は一般的には次の式で表されます。

NDVI ＝ ( 近赤外 － 赤）／（近赤外 ＋ 赤）

　NDVIは－1から+1の値をとり，値が１に近いほど，植生の密度や活性度が高いことを表します。次に，NDVIを計算する方法を説明します。

1. アイコンパネルからInterpreter > Spectral Enhancement > Indicesを選択
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2. Input Fileに90_landsat.img選択

3. Output Fileに90_ndvi.imgを指定

4. SensorはLandsat TMのままとし，Select FunctionもNDVIのままでOKをクリック

4.4. 植生域の抽出

　NDVIは植生の密度を表しているとすれば，ある閾値以上を植生域，それ未満を非植生域とみなすことが可能かもしれません。次に，植生域を抽出することを試みます。今回は，計算や処理をカスタマイズできるSpatial Modelerを使って植生域を抽出します。

1. アイコンパネルからModeler > Model Makerを選択。

2. 新たに，New_Modelウィンドウと，このウィンドウの右側にツールバーが表示されます。ツールバーにあるアイコンを選択し，左のウィンドウをクリックすると，右側のツールバーで選択されたアイコンが表示されます。まずは以下の図のように表示させます。
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　①Raster Objectは，処理に使用する画像を入力することができます。その入力された画像を使って，②Function Objectで計算や処理を実行します。そして，再びRaster Objectで計算や処理結果を画像で出力します。その一連の流れを③矢印で繋げます。つまり，上のRaster Objectは入力（呼び出す）する画像をあらわし，処理を行った後に，下段のRaster Objectでは，処理後の画像となり，このオブジェクト内で保存名や保存先を指定することになります。


3. Raster Objectの設定は，そのオブジェクトをウィンドウ内でダブルクリックすることで設定ウィンドウが表示されます。一番上のRaster ObjectにはFile Nameで処理対象の入力画像(ndvi.img)を選択します。 
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4. 下段のRaster Objectには出力先とファイル名を指定します。Ignoreにチェックを入れます。また，File typeを，ContinuousからThematicに変更してください。ファイル名はvege_mask.imgとします。

5. 処理の内容を指定します。Function Objectをダブルクリックし，Function Definitionウィンドウを表示させます。Available Inputs:には，読み込んだデータの一覧が表示されており，その下の計算式を入力するエリアに反映されます。
　はじめに，FunctionsをConditionalに設定し，下に表示される一覧の中の，「EITHER <arg1> IF ( <test> ) OR <arg2> OTHERWISE 」を選択してください。下部の計算式の入力部分に反映されます。この式では，「<test>の条件を満たす画素に<arg1>を与え，それ以外の条件の画素は<arg2>を与える」という命令です。そして計算式は「EITHER 0 IF ( $n1_ndvi > X ) OR 1 OTHERWISE」とします。画素値Xより大きい画素に0を与え，それ以外は1を与える命令となります。"$n1_ndvi"がNDVI画像のことを表しています。
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6. New_Modelのウィンドウに戻り，ウィンドウ上部にあるメニューアイコン[image: image54.bmp]をクリックすると，処理が始まります。

　このように，植生域と非植生域で2値化画像を作成することをMasking（マスキング）と呼びます。元画像と作成したマスクキングした画像を，同じウィンドウに重ね合わせてみます。

1. Viewerウィンドウに元画像90_landsat.imgを表示

2. Viewerウィンドウの左のアイコン[image: image55.bmp]をクリックしてマスク画像vege_mask.imgを選択する。そして， Raster OptionsタブをクリックしてDisplay as:をPseudo Colorを選択し，Clear Displayのチェックをはずす

3. Viewerウィンドウのメニューから，Raster > Attributesを選択。Raster Attributes Editorウィンドウが表示される

4. Rowが1と２の両方ともOpacityは1となっているはずなので，Rowが0のOpacityを0とします。
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5. Raster Attributes Editorウィンドウを閉じる。保存するか聞かれるので，Yesを選択します。

　Opacityは，特定の値を画素の持つ色を表示させるか，表示させないかを指定するもので，0では非表示，1では色を表示させることができるようになります。また，ViewerウィンドウのメニューであるUtility内にある，Swipe，Blend，Flickerは，重なった画像の後ろ側を効果的に表示させることが可能なので試してみてください。

4.5. 水域の反射特性

　水域は，地表面の反射と異なる反射特性を示します。波長が長くなるほど，電磁波は水に吸収されやすくなります。海が青いのは，青や緑の短い波長の電磁波が反射されるためです。ただ，水深が浅い場合は，底の反射が届く場合があり，青や緑の反射がさらに強くなる場合があります。
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（図の出典：http://web.sfc.keio.ac.jp/~kipinga/RSI/rs6/）

　また，水の中の沈殿物の存在(Suspended Sediment, SS)により影響を受け，緑の波長帯の反射が強まることがあります。また，水質の悪化が富栄養化をもたらし，Chlorophyll-aの濃度が増加するため，近赤外の波長の反射が強くなる場合があります。

　SSやChlorophyll-aの影響があっても，近赤外より長い波長帯では電磁波の吸収の割合は大きく，ほとんどセンサに戻ってくることはありません。この特徴を利用して，水域と陸地を分けてみましょう。水域を対象に分析する場合には，水域と陸地を分離することは必要な作業となります。次に水域のマスク画像を作成します。

　次に，このマスキングした画像と元の画像で積を求めます。これにより，元画像における水域の画素を抽出することができます。抽出を行うには，再びSpatial Modelerを使用します。今回は方法を詳しく説明しません。ヒントとしては，画像を入力するRaster Objectを2つ置き，Function Object内の計算は，マスク画像と元画像の積を求める計算式を入力してください。また，出力のRaster Objectには，必ずIgnore Input as Zeroにチェックを入れてください。水域のみを抽出した画像は，水域だけの画素値でストレッチが行われるため，フルシーンの場合と比べて，水域の内部の細かい違いが表現されます。Suspended Sedimentは緑の波長帯の反射が強まることが多いので，Gray Scaleでバンド3を表示させてみましょう。

　Chlorophyll-aは，中国科学院によるとバンド4とバンド３の比演算との相関が高いということが示されています。この画像にも適用してみましょう。今までの説明した方法を利用することで計算することが可能です。ただ，割り算の場合はエラーが起きるので，[http://www.esrij.com/support/erdas/faq/divideby/divideby0.html]を参考にしてください。
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5. 主成分分析

　主成分分析(Principal Component Analysis)は、多変量のデータから，変量間それぞれの相関を無くし、しかもより低次元の変量によって，元の計測値の特性を記述するための多変量データ解析手法です。衛星画像は，1つの画素に7つのバンドのデータなので，多変量のデータといえます。次の図のように2変量であるx1とx2で主成分分析を行う場合を考えます。
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（図の出典：Erdas Imagine Field Guide）

　ここで設定したz1というのは，最も分散（情報量）の大きい軸，z2はz1と直交して，次に分散の大きい軸です。z1は，x1とx2と最も相関が高くなっていますので，z1だけでこの2変量のデータを評価することができることになります。これを第1主成分(PC 1)と呼びます。次に分散が大きい軸で，z1に直交するz2は，第2主成分(PC 2)と呼びます。第1主成分と第2主成分の軸は直交しているため，それぞれの主成分は個別に評価が可能となります。

　第1主成分は今回の例では2つの変量で1つの変量となりますが，この変量を主成分得点と呼びます。主成分得点は以下の式で求められます。

z1 = a11・x1 + a12・x2
z2 = a21・x1 + a22・x2
　z1，z2が主成分得点，aが因子付加量です。x1，x2が観測データです。主成分分析を行うとaが自動的に決定され，観測データごとに主成分ごとの主成分得点が計算されます。プロットした図で主成分得点を表すと，観測データが主成分軸に垂直に投影された点と，主成分軸が必ず通る全データの重心の距離で求められます。

　主成分分析は，自動的に計算ができますが，その主成分がどのような情報として低次元化されていて，何を表しているのかは，自分で解釈しなければなりません。主成分の意味を解釈するには，寄与率と因子付加量が重要です。

　寄与率は，その主成分が観測データのもつ情報量の何％を説明したのかを表す指標です。今回は2変量でしたが，第1主成分は多くの情報を持ち，第2主成分の情報量はあまり多くありません。寄与率が数％以下と低いと，意味が無い可能性がありますので，解釈の必要があるか無いかを寄与率から判断しなければなりません。

　因子付加量は，各主成分の特徴を把握するために最も重要です。因子付加量は上記の式によると，主成分得点の大小を左右するので，因子付加量がその主成分の解釈の鍵となるのです。

＜参考ウェブサイト＞

· NASA GSFC 「Remote Sensing Tutorial － Section 1」：http://rst.gsfc.nasa.gov/Sect1/Sect1_14.html
　衛星画像で主成分分析を行う際には，バンド6の熱画像を解析から除く必要があります。はじめに，そのための方法を説明し，その後で主成分分析を行う方法を説明します。

1. アイコンメニューInterpreterから，Utilities > Layer Stackを選択

2. Layer Selection and Stackingウィンドウが表示し，Input Fileに衛星画像(90_landsat.img)を選択し，Outputにはファイルの保存先ディレクトリを指定し，ファイル名は90_landsat_2.imgとする 

3. Layerを1にしてAddをクリックする。次にLayerを2として，Addをクリックする。この作業をlayer が7まで繰り返すが，Layerが6のとき，Addは行わない
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つまり，バンド1からバンド5までがLayer1～5で，バンド7がLayer6となる

4. OutputはUnsigned 8bitであることを確認し，Ignore Zero in Statsにチェックを入れ，OKをクリックすると，処理が実行される。

　Layer Stackについては以下のサイトも参照して下さい。

＜参考ウェブサイト＞

· ESRIジャパン「LGGM製品サポート FAQ－Layer Stack」
http://www.esrij.com/support/erdas/faq/ii_ut_layerstack/ii_ut_layerstack.html
　以上の作業によって出力されるデータは，レイヤー６はバンド7を表します。次に主成分分析を行います。

1. アイコンメニュー"Interpreter"から，"Spectral Enhancement" > "Principal Comp"を選択
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2. Principal Componentウィンドウが表示され，Input Fileに(90_landsat_2.img)を選ぶ

3. Outputにはファイルの保存先ディレクトリを指定し，ファイル名は90_pca.imgと指定

4. Eigen Matrix内にあるWrite to fileにチェックを入れ，Output text fileにファイルの保存先ディレクトリを指定し，ファイル名90_pca.mtxを指定

5. Eigenvalues内にあるWrite to fileにチェックを入れ，Output text fileにファイルの保存先ディレクトリを指定し，ファイル名90_pca.tblを指定

6. Output OptionsにあるIgnore Zero in Statsにチェックを入れる

7. Number of Components Desiredには，6を選択し，第6主成分まで計算させる設定にする

8. OKをクリックし，処理を実行

　出力されたファイルはLayer1には第1主成分の画像が入っているように，レイヤー番号と主成分が対応しています。Eigen MatrixとEigenvaluesで出力されたテキストファイルには，それぞれ寄与率と因子付加量の情報が入っています。ファイル内の構造は以下の図のようになっています。
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　"Eigen Value"は寄与率ではなく，固有値と呼ばれる値が入っています。寄与率は，全固有値の和を計算し，この値で割ることで得られます。

6. 土地被覆分類

　衛星画像の処理の1つとして，画像中の画素値を統計的な方法によって複数のクラスに分ける処理を行うことがあります。この処理のことを土地被覆分類と呼びます。元の画像から抽出した情報の性質をから，地表面上の意味のある特徴にするためにクラス分けを行います。

　土地被覆分類の方法は，解析者が分類したいクラスの教師データに基づいて分類を行う「教師つき分類」と，教師データを用いずに，近い画素値でグループ化する「教師なし分類」に分けることができます。前者の代表的な手法は「最尤法」で，後者の代表的な手法は「ISODATA」です。

6.1. 教師なし分類（ISODATA）

　Iterative Self-Organizing Data Analysis Technique（ISODATA）法は，繰り返し画素を分類していくことで，データ内のスペクトルパターンを自動的に明らかにし，スペクトルパターンが似た画素どうしでグルーピング（分類）していく方法です。

　この方法は3つのパラメータがあらかじめ必要となります。1つ目はクラス数(分類項目数)で，この数が分類結果に大きく影響を与えます。2つ目では，前のクラスと変化しない画素の割合を決め，分類が収束したとみなして，分類を終了させるための閾値を指定します。3つ目が繰り返し回数で，任意の回数で分類を終了させることができます。

　2バンドのデータを例としてISODATA法について説明します。5つに分類してみることにします。はじめに，それぞれのバンドごとの平均と標準偏差が計算され，初期クラスの5つの重心が決められます。
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　計算された5つの重心がクラスの平均値とみなされ，それぞれの画素は，各クラスの重心との距離が計算されます。そして最も距離が近いクラスに所属されます（下図左）。
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（図の出典：Erdas Imagine Field Guide）

　全ての画素について所属するクラスが決定されると，クラスごとに画素値を計算し，新たな重心が決定されます。そして，先ほどと同様に，画素は各クラスの重心との距離を計算し，最も距離の近いクラスに所属されます（上図右）。この作業を繰り返すことで，分類を収束させます。最終的には，あらかじめ設定した，前のクラスタリングで変化しない割合や，クラスタリング回数のパラメータにから，この繰り返しは終了させます。実際の分類方法の流れを説明します。

1. アイコンパネルからClassifier > Unsupervised Classificationを選択
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2. Unsupervised Classificationウィンドウが表示されるので， Input Raster Fileに第5章でバンド6を除いた90_landsat_2.img を選択

3. Output Classifier Layerにチェックをいれ，出力ディレクトリを指定して，ファイル名はisodata_lcc.imgとする

4. Output Signature Setをチェックし，出力されるテキストファイルの保存先とファイル名を指定（ファイル名はisodata_lcc.sig）

5. Number of Classに分類したいクラス数を指定

6. Number of Iterationに分類の繰り返し回数を指定

7. Convergence Thresholdに閾値を指定しOKをクリックする

　土地被覆分類画像を表示させます。分類画像に色分け表示させます。

1. アイコンパネルViewerを選択し，Viewerウィンドウを表示させる

2. Raster Optionsタブをクリックし，"Display as"が"Pseudocolor"であることを確認

3. 分類画像を表示させる

4. ViewerにあるRasterメニューから"Attributes"を選択

5. Raster Attribute Editorが起動したら，ウィンドウ内のEditを選択し，Colorsをクリック
[image: image69.png]Sice ethod  [IHS Slce i [N =
End Color

SiceType:  [Byvaue = _
Hue Varaton:  [Marimal =] Naberotevels |7 =

Apply e Heb |





6. 何も設定をかえずにApplyをクリックすると，色表示がかわる

7. Raster Attribute Editorに戻り，Color列の下部の色をクリックすると，色が変更できるので，任意に色表示を変更させることができる

8. 一番左の列の数字が画素値である。右の列のClass Namesには画素値に対応した分類クラスの名前が設定できる

9. 設定をFileメニューのSaveで保存する

　分類される数はなるべく多めにし，後で分類を統合して6前後のクラスに設定すると良いでしょう。そのためには，分類されたグループは何を表しているのかを解釈しなければなりません。Signature Editorを起動し，クラス別のバンドごとの平均値をグラフ表示させます。

1. アイコンメニューからClassifier > Signature Editorを選択

2. Signature Editorウィンドウが表示されるので，File > OpenでISODATAを行った際に出力したSignatureファイル(拡張子は.sig)を読み込む

3. メニューEdit > Colors > Level Sliceを選択し，Colorsの色をグレースケールからPseudocolorに変更
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4. ウィンドウ内のアイコン[image: image71.bmp]を選択する

5. Signature Mean Plotウィンドウが表示され，アイコン[image: image72.bmp]は1つのクラスの表示となる。クラスの切り替えは，Signature Editorウィンドウ内の表にある，"Class #"に右の列にある，[image: image73.bmp]の下部をクリックすること表示されるクラスが決まる。そしてSignature Mean Plotの表示がクリックしたバンドのものに切り替わる

6. [image: image74.bmp]をクリックすると，全てのクラスの平均値がプロットされる
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　次に，散布図に分類したそれぞれのクラスがどのあたりに分布しているのかを示します。

1. 4.1で作成したバンド3とバンド4の散布図を表示させる

2. Signature EditorウィンドウのメニューFeature > Objectをクリック

3. Signature Objectウィンドウが表示され，Viewerは1のままでSelectをクリックし，散布図のウィンドウを1回クリックする
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4. Plot Ellipseにチェックを入れ，Plot Meanにもチェックを入れる。OKをクリックすると，散布図にクラスの平均値が表示され，Std. Devの数字の設定に応じた範囲の楕円が描かれる

5. 全てのクラスで描画したい場合は，Rowの列で右クリックしてSelect Allを選び，黄色に変化させた上で，Signature Objectウィンドウに戻り，OKをクリック
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　以上のような，散布図や統計量を駆使して，適切にクラスにラベル付けを行うことや，クラスの統合を検討します。他にも，元画像の上に分類図を重ねて表示させ，Swipeなどの方法で判読する方法や，Raster Attribute Editorで判断したいクラスをOpacityで色表示を切り替え，下の画像を表示させた上でクラスを推測する方法等が考えられます。

　Raster Attribute Editorで同じクラスと判断したものの色を同一にし，クラス名は表の右側にある"Class Names"に記入します（日本語は対応していない）。File > Saveで設定を保存できます。また，別のソフトウェアであるArcGISのSpatial Analyst内にある再分類を用いると，効率的に分類結果を統合することができるはずです。

6.2. 教師付き分類（最尤法）

　教師付き土地被覆分類で最も使用頻度の高い手法である，最尤法について説明します。最尤法は，各クラスに対する画素値の尤度を求め，尤度が最大となるクラスに画素を分類する手法である。尤度とは，画素値が観測されたときに得られる確率である。トレーニングデータ(教師データ)を基にして，設定したクラスごとに確率密度関数が設定される。それを表したのが下の図である。
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（図の出典：http://www.fes.uwaterloo.ca/crs/geog165/srs.htm）

　横軸が画素値，縦軸が尤度とする。2つのクラスがあるが，それぞれのクラスは正規分布すると仮定して，あらかじめ教師データを設定しておく。そして，全体に適用し，画素値からクラス別の尤度を求める。そして最も尤度の高かったクラスが，所属すべきクラスであると判断され，画素に対して，そのクラスを示す値が格納される。

　この手法では，①クラス数が不適切な場合，②クラスが正規分布を仮定できないとき，③トレーニングデータが不十分であった場合は，分類精度が低下します。

　分類を行う流れは，はじめに教師データの取得を行い，教師データの評価を行って，分類にうつります。

1. アイコンパネルからClassifier > Signature Editorを選択

2. Viewerを起動し，landsat_90_2.imgを表示

3. Signature EditorのメニューからEdit > Image Associationを選択し，landsat_90_2.imgをSignature Editorと関連付ける衛星画像として選択

　これで教師データを取得する直前まで進みました。次にViewerに戻り，教師データの取得を行います。教師とする箇所はAOI(Area of Interest)と呼ばれる領域をViewerで指定します。今回はRegion Growing Algorithmsにより，1点を選択して，近接画素で均質な画素を抽出する方法から，教師データを取得することにします。

1. Viewerにlandsat_90_2.imgを表示させる

2. メニューからAOI > Toolsを選択。Viewerの右側にAOI Toolsウィンドウが表示される

3. メニューからAOI > Seed Propertiesを選択。Region Growingの設定を行う。Growingさせる面積は500 pixelsとし，Spectral Euclidean Distanceを10とする
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4. Viewerに戻り，AOI Toolウィンドウのアイコン[image: image80.bmp]を選択。トレーニングを取得したい箇所をクリックすると，均質な領域が生成される
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5. この領域をトレーニングとしたい場合，Signature Editorに戻り，[image: image82.bmp]を選択するとテーブル内に新しいSignatureが作成される

　以上の方法で，必要なクラスの数だけトレーニングサンプルを取得します。サンプルの統計的な評価は，Statistics，Evaluate > Separability，ISODATAの時に説明したFeature > Object，Mean Plotも利用可能です。詳しい説明は次のサイトも参考にしてみてください。

＜参考ウェブサイト＞

· ESRIジャパン「LGGM製品サポート FAQ－Signatureの評価」
http://www.esrij.com/support/erdas/faq/class_sig/classify_sig.html
· ESRIジャパン「LGGM製品サポート FAQ－分類に有効なバンドを知りたい」
http://www.esrij.com/support/erdas/faq/classify_sep/classify_sep.html
　必要なトレーニングサンプルの評価方法として，Contingency Matrixによる評価を説明します。ここでは，トレーニングサンプルで抽出した画素のみで分類を行い，どれほどトレーニングサンプル内で誤分類が発生するのかを示します。例えば，森林のクラスと設定したのに，他のクラスに分類されてしまう割合が多いと，後に全体に展開した時も，精度が悪いことが推測できます。

1. Signature EditorのメニューEvaluate > Contingencyを選択

2. 表示されるウィンドウの設定は変更せずに，OKをクリック

3. 新しいウィンドウにマトリクスが表示される。横の列が実際のクラス，縦の列が実際に分類して推測されたクラスを表している

　この処理によって，分離が難しいクラスや，教師データが不適切なのか等を検討し，クラスを除去したり，新たらしく教師データを取得するなど，Signature Editor内を編集してください。それが終わったら，画像全体の分類を実行します。

1. Signature EditorメニューのClassify > Supervised Classificationを選択

2. Output Fileにファイル名(landsat_mlc.img)を指定

3. Okをクリック

　この方法は，分類実行者がいかに試行錯誤したかが，精度の鍵を握ります。何度かがんばってやってみましょう。

7. 土地被覆変化

　衛星画像を使って土地被覆状態の変化を検出することは，衛星画像解析の主要なアプリケーションの1つとなっています。なぜなら，衛星画像は周期的にデータを取得可能で，広範囲の地表面の状態を把握できるからです。例えば，農地変化，土地利用変化，森林減退，植生の季節変化，災害モニタリングなど多岐にわたります。多くの手法は，2時期の衛星画像を使い，変化を把握します。本章では，2時期の衛星画像を用いて，土地被覆の変化の情報を抽出する方法や，変化した箇所を効果的に示すテクニックについて紹介し，演習を進めていきます。

　衛星画像は2000年9月に撮影されたLandsat 7 ETM+を使い，10年間の変化をみていくことにします。

7.1. 差分画像

　はじめに，それぞれの画像を表示させ，定性的な比較を行うことにします。2枚の衛星画像を重ねて表示させる方法は，以前説明した，Swipe，Blend，Flickerですが，2つのViewerをリンクさせることで，同じ場所を表示させます。

1. Viewerを表示させ，90_landsat.imgを表示

2. もう1つViewerを表示させ，00_landsat.imgを表示

3. 片方のViewerの画面上を右クリックし，Geo. Link/Unlinkを選択

4. もう片方のViewerの画面をクリック

　どちらか片方のウィンドウに白いカーソルが表示されます。その四角の範囲が，もう片方のウィンドウの衛星画像の表示範囲と同じであることを表しています。カーソルはドラッグで移動可能で，片方の画面表示もそれに応じて切り替わります。

　今回は，正規化植生指標NDVIの変化に着目します。NDVIは植生の活性度との相関が高いため，植生の存在を表すのに効果的であることを4章で説明しました。つまり，2時期のNDVIの違いによって，植生分布の変化が把握できると考えられます。従って，NDVI画像の差分を計算してみることにします。計算式は以下の通りです。

NDVI差分画像 ＝ 2000年NDVI － 1990年NDVI

1. Indicesで2000年のNDVIを作成。ファイル名は00_ndvi.imgとする

2. Interpreter > Utilities > Operatorsを選択する。
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Input File #1に00_ndvi.imgのファイルを選択し，Input File #2には90_ndvi.imgを選択する。Output Fileには出力先とファイル名を入力し(ndvi_diff_00_90.img)，Operatorは差分なので，「－」を選択する。これにより，「#1 － #2」という式となる。データのタイプは，NDVIで差分を行うため，小数点で正負が付くFloat Doubleとする。

　NDVIが減少した箇所はマイナスとなるため，黒っぽくなります。NDVIが増加した箇所はプラスとなるため，白っぽくなります。
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　次に2時期のNDVIを散布図に表現してみることにします。土地被覆に変化が無い場合を仮定すると，散布図上では傾き1で切片が0の直線付近(下の図の点線)に画素が集中するはずです。つまり，それよりはずれると，値の変化が大きいため，変化が起きた可能性がある画素を表すことになります。
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　1990年のNDVIをLayer 1に，2000年のNDVIをLayer 2にして，Layer Stackを実行してください。それをFeature Space Imagesにより散布図を作成してください。方法は今までに説明がなされているため，特に必要はないと思います。散布図を作成した後に，Signature Editorを起動し，メニューのFeature > View > Linked Cursorsを使って，実際の差分画像の結果と散布図の対応を見てみましょう。

　先ほどはNDVIの差分を行いましたが，バンドによる差分も考えられます。それは，2時期で同じ土地被覆であるならば，反射特性は同一で，それぞれのバンドの画素値はほとんど変化がないと考えられ，土地被覆が変化したならば，その土地被覆の物質の反射特性に変わるわけですから，いずれかのバンドの画素値が大きく変化するはずです。この考え方に基づいて，同一バンドどうしで差分を行い，土地被覆の変化を把握します。NDVIの時と同様に差分画像を作成して下さい。ファイル名はdiff_landsat_00_90.imgとします。

＜注意＞

　00_landsat.imgはバンド6が含まれています。全バンドで差分を行う場合は，90_landsat.imgで行ってください。00_landsat.imgのバンド6を除く場合は，00_landsat_2.imgとして，90_landsat_2.imgと差分を行なって下さい。
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　上の図の左は1990年のR,G,B=3,4,2カラー合成です。右側は同一バンド間で差分(1990年から2000年を差し引く)を行い，同様にカラー合成を行った画像です。

7.2. 差分画像の閾値

　２時期の画像で差分を行った結果，値の絶対値が大きい画素ほど，土地被覆の変化が起きた可能性が高い箇所であるといえるはずです。このことの概念図を下に示します。
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　Usually LowとUsually Highが値の変化が大きかった箇所といえます。従って，変化が起きた箇所の可能性が高く，それ以外のMeanの周辺部分は，多少の値の変動はあるものの，変化が起きていないと推測します。この外側を客観的に決定する方法として標準偏差（σ）が重要となります。標準偏差の意味は，次のサイトを参照にすると良いでしょう。

＜参考ウェブサイト＞

· 青木繁信「統計学自習ノート 標準偏差」
http://aoki2.si.gunma-u.ac.jp/lecture/Univariate/sd.html
　正規分布を仮定したとすると，平均値±1標準偏差範囲内の場合，全データの68.27%が含まれることを意味します。さらに，平均値±2標準偏差の場合，全データの95.45%が含まれることを意味します。従って，この基準を変化とみなす閾値として，閾値をこえる画素を抽出してみましょう。まずはNDVI画像でやってみることにします。標準偏差は3σとします。

1. ViewerにNDVI差分画像(ndvi_diff_00_90.img)を表示させる

2. Image Infoを表示させ，平均値と標準偏差をメモする

3. 平均値±3標準偏差を計算する

4. Spatial Modelerを起動させ，FunctionsはConditionalを使い，その中のConditional関数（CONDITIONAL { (<test1>) <arg1> , (<test2>) <arg2> , ... }）を使用します。test1,test2が条件式です。まずtest1には 「差分画像 > 平均値 + 3×標準偏差」という条件式を与え，<arg1>にはその条件式<test1>が真であったときに返す値となります。今回は1という値を与えます。次に，<test2>には「差分画像 > 平均値 － 3×標準偏差」という条件式を与え，返す値<arg2>は2とします。

5. Raster Objectのファイル名は3std_thresh_diff_ndvi.imgとする

　他の設定も完了させ，実行させてください。0，1，2の３つの値で表現された画像が作成されます。画像を表示させるときは，Raster Optionsタブから，Display as をPseudo Colorに選択して表示し，メニューのRaster > Attributesを選択し，Colorsの列に表示されている色を変更させると効果的に，閾値をこえた箇所を示すことができます。

　今回は3×標準偏差としましたが，2×標準偏差のように，値を変えてみると良いと思います。変化した箇所の多さによって，閾値は変化すると考えられ，ある程度は試行錯誤が必要であると考えられます。

7.3. 輝度補正

　２時期の画像は，変化が全くない理想的な状態の場合，それぞれのバンド間の画素値は，同じ値となるため，次のような式となるはずです。

1990年画素値 = 2000年画素値

　しかし，そのようにいかないことが多いのです。それは，大気の状態によって，画素値が影響を受けることがあるためです。以下の図はそのような状態を表した例です。
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　２時期の同一バンドで散布図を作成したとします。理想としては，散布図上の点線で表示された直線が２時期間の対応となるはずです。しかし，大気の状態等による影響で赤色の線のように，対応関係がややずれる場合が考えられます。この問題について，このあと説明する処理を実行することで，先の図の赤色の直線のような関係を見出し，画素値をどちらかの時期に補正することにします。この補正のことを，輝度補正と呼びます。

　補正する方法の代表的なものが，2時期で回帰直線を求め，その直線式を用いてどちらかの時期に補正する方法です。この方法では，土地被覆に大きな変化が無い場合は有効ですが，変化が起きている面積が多いシーンだと，うまくいかない場合があります。また，季節が異なると植生の反射特性が異なるため，輝度補正はなるべく同一季節で行うことが適切だと考えられます。

　今回は，Radiometric Control Set (RCS) Methodと呼ばれる方法を利用して，輝度補正のための直線式を求めます。まず，はじめにNDVIの補正を試みることにします。1990年の画像を補正し，2000年の画像に合わせるようにした後で，差分画像を作成します。

1. 散布図の画像ファイルを表示させ，散布図を作成するために使用した2時期のNDVI画像を表示させる

2. Classifier > Signature Editorを表示させ，Feature > View > Linked Cursorを選択

3. Selectをクリックして散布図のウィンドウをクリックし，Linkをクリックし，NDVI画像をクリックする

4. NDVIが2時期とも高い箇所を10点抽出し，2時期の平均値を求める。また，NDVIが2時期とも低い箇所（例えば水域）を10箇所抽出し，2時期の平均値を求める

5. この高い箇所の平均値と低い箇所の平均値の2点をつなぐ直線式をもとめる。式は以下の通りとする
（2000年NDVI）= a・（1990年NDVI）＋ b

6. 係数aとbを求め，Spatial Modelerを使って1990年画像に適用する。Spatial Modelerを使用すること。出力ファイル名はndvi_c90.imgとする

7. Operatorで2000年から1990年を差し引く計算を行う。出力ファイル名はndvi_diff_00_c90.imgとする

　次に2時期の同一バンド間で輝度補正を行ってみます。例としてバンド3の補正を行います。NDVIの場合と同様に，1990年を補正して，2000年と差分を行います。

1. Layer Stackを利用して，1990年バンド3をLayer 1，2000年バンド３をLayer 2として新しいファイル（band3_00_90.img）を作成する

2. band3_00_90.imgを使って，Feature Space Imageにより，散布図を作成する

3. Signature Editorを起動し，Edit > View > Link Cursorで散布図とband3_00_90.imgを関連付ける

4. 両方とも2時期で明るさの変化が無い，明るい箇所（おすすめは空港）と暗い箇所をそれぞれ10ピクセルほど抽出して，平均値を求める

5. 平均値を元に，直線式を求める

6. 1990年のバンド3に直線式を適用し，補正画像を作成する。ファイル名はband3_c90.imgとする。

7. Operatorを使って，2000年のバンド3から，輝度補正した1990年バンド3を差し引き，差分画像を作成する。ファイル名はband3_diff_00_90c.imgとする。

7.4. 比演算

　単純な差分による方法では，変化の値のスケールは同一とみなしています。しかし，同じ値で変化したとしても，変化の意味が異なる場合もあります。例えば，画素値が5で，10へと変化した場合，画素値の変化は５で，比は２となります。画素値が95で，100に変化した場合，画素値の変化は先ほどと変わらず５ですが，比では1.05となるわけです。植生を考えた場合，画素値が5から10に変化したということは，植生の活性度が倍になったと考えるべきでしょう。95から100への変化は，植生内のわずかな変化に過ぎないと考えられます。このように，比演算を行うことで，値が低い部分のわずかな変化を強調することが可能となります。

　しかし，比演算を行う際に注意すべき点がいくつかあります。分母は０がありえないように，０でわることはできません。０で割ろうとすると，エラーが必ず帰ってきます。この点は注意しないといけません。また，比演算で計算される値は，線形的な変化ではありません。例えば，比演算の結果が0.5と2となった場合，表す意味は同じで，前者は値が1/2となり，後者は2倍になったと考えられます。しかし，１が変化無しとすると，１から0.5に変化した場合と，1から2への変化は，同じ意味とは言えません。この問題点を解決する方法として，対数変換が用いられます。例えば，0.5，1，2を自然対数に変換すると，-0.693，0，0.693となります。したがって，標準偏差は平均値を使って，今まで差分で行ってきたような閾値を決定することが可能となります。

　今回は２時期のNDVIで比演算を実行してみます。

1. 90_ndvi.imgと00_ndvi.imgを，Spatial Modelerを使って，0から255の値を持たせるようにスケールを変更させる。NDVI画像に1を加え，127.5をかけると0から255の値をとる画像になる。ファイル名はそれぞれ，90_ndvi_8bit.img，00_ndvi_8bitとする。

2. 新しく，Spatial Modelerを立ち上げ，Raster Objectを2つ用意し，インプットとして90_ndvi_8bit.img，00_ndvi_8bitを読み込む。ただし，Declare asの部分は必ず，floatにすること

3. Function Objectには，2枚の画像の比演算を実行し，自然対数に変換する。演算式としては，Log(2000年NDVI／1990年NDVI)となる。

4. ファイル名をndvi_ratio.imgとし，Data typeをFloat Doubleにして，処理を実行する。

7.5. 主成分分析

　土地被覆変化を把握する手法として主成分分析を活用します。主成分分析の使い方は2通りあると考えられます。それぞれで主成分分析を行い，変化を差分などにより比較する方法と，すべてのバンド(バンド6は除く)を一度に主成分分析を実行する方法があるます。前者の手法では，因子負荷量が2時期で独立に決まるため，2時期で同一主成分を比較することが適切でない可能性も考えられます。今回は，後者の方法で主成分分析を実行します。

1. Layer Stackで，全てのバンドを1つのファイルにする。Layer 1～6に90_landsat_ex.imgにある全てのバンド，Layer 7～11がバンド6を除いた00_landsat.imgを使う。ファイル名はall_landsat_90_00.imgとする

2. Interpreter > Spectral Enhancement > Principal Compを選択し，主成分分析を実行する。Input Fileにall_landsat.img，Output Fileはpca_all_landsat.imgとする。Eigen MatrixとEigenvaluesにチェックを入れ，ふぃある名を指定する。Number of Component Desiredは12とする。

7.6. 土地被覆分類

　土地被覆分類を2時期で行い，クラスの変化で土地被覆の変化を検出します。今まで行ってきた差分画像や比演算を行い，閾値を決める方法では，土地被覆の中のどのクラスから，どのクラスへと変化したのかという情報が明確ではありません。しかし，それぞれの時期で土地被覆分類が適切に行われていれば，例えば，「森林」から「市街地」へ変わったというように，わかりやすく変化を検出できるようになります。今までに行った土地被覆分類の方法を基に，土地被覆の変化を把握します。

　土地被覆分類による変化検出のアプローチは2つ考えられます。1つ目は2時期でそれぞれに土地被覆分類を行う方法，2つ目は2時期のバンドを全て入れて(Landsatであれば，12バンド)，教師なし分類を行う方法です。まずは前者の方法から行いましょう。

　2000年の画像を使って，1990年と同様に土地被覆分類を実行してください。土地被覆のクラスは，1990年と統一させます。分類画像のファイル名ですが，教師つき分類はlcc_00_sup.imgとし，教師なし分類はlcc_00_unsup.imgとします。

　土地被覆分類を実行し，6クラスに分類したとします。2時期であれば36通りの土地被覆分類の組み合わせが発生することがわかります。この全通りをMatrixという機能を使って色分けで表示させます。

1. Interpreter > GIS Analysis > Matrixを選択。

2. Thematic Image #1に1990年の分類画像を入れる。Thematic Image #2に2000年の分類画像を入れる。Output Fileにファイル名(matrix_1_90_00.img)を指定する
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ファイル名を入力する欄の下部にあるSet Up Recordでは，それぞれの分類画像の値を変更することが可能である。
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New Valueの値を基に，2つの分類画像を組み合わせる。

3. OutputをUnsigned 8bitにして，ＯＫをクリックする。

4. Output FileをViewerに表示させる。Raster TypeはPseudo colorにすること。

5. ViewerメニューからRaster > Attributesを表示させる。Raster Attributes EditorのColumnに，入力した分類データのファイル名が表示されており，その下部の表の値は，それぞれの分類画像の画素値を表している。

6. 右側のColumnのColorsで色を変更する。

　Colorsで色を変更することで，注目したい変化の色を変化させることが可能となります。また，Opacityで色の表示，非表示を切り替えることもできます。

　次に，2時期の分類画像でクロス集計を行い，1990年から2000年の土地被覆の変化の割合を定量的に示すことにします。

1. アイコンパネルからInterpreter > GIS Analysis > Summaryを選択する。

2. Summaryウィンドウが表示される。Input Zone Fileには1990年の分類画像を入力し，Input Class Fileには2000年の分類画像を入力する。
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3. Output OptionsはInteractiveを選択して，OKをクリックすると，Summary By Zoneウィンドウが表示される。Zone no.は1990年の分類画像のクラスを表している。下部の切り替わる表には，クラス1990年のクラスの中で2000年になって変化または変化がないクラスの割合が表示される。

4. Output OptionsをOutput Report Onlyをクリックし，出力テキストファイル名を指定する場合は，テキストビュアーで結果を見ることができる。
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